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Moxa Tech Note

Using Siemens S7-300 PLC to Perform

Acyclic Read and Write on MGate 5102

1. Application Description

A. Objective

This document describes how to use Siemens PLC to perform Acyclic Read and Write
on MGate 5102-PBM-PN to get PROFIBUS Status Word and Communication List or to
set PROFIBUS Control Word.

In this application, the administrator wants to manage MGate 5102-PBM-PN

diagnostic information.

For example, to get and set PROFIBUS operation mode and

to get PROFIBUS Communication List via Siemens PLC.

Goals

This document shows you how to:

5102-PBM-PN.

2. System Topology

Use Siemens PLC to do Acyclic Read and Write.
Get ROFIBUS Status Word and ROFIBUS Communication List from MGate

Set ROFIBUS Control Word from MGate 5102-PBM-PN.

The following figure shows a system architecture in which MGate 5102-PBM-PN, PC1
(running SIMATIC Step 7), Siemens S7-300 PLC, and Pro-face GP-4501 TW (a HMI
device to control and monitor PLC) are connected to the Ethernet network. MGate
5102-PBM-PN connects to MGate 4101-MB-PBS via a PROFIBUS cable. Pro-face
GP-4501TW controls and monitors Siemens S7-300 via Ethernet.

Pro-face
GP-4501TW

PC1 (SIMATIC Step 7) |

Siemens S7-300 PLC

MGate 5102-PN-PBM

Ethernet Cable

G

Switch

PROFIBUS
Cable

MGate 4101-MB-PBS
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Acyclic Read and Write on MGate 5102

3. Hardware and Software Requirements

3.1. Hardware Requirement
A. Siemens SIMATIC S7-300 PLC:
Processor: CPU 315-2 PN/DP
Article Number: 6ES7315-2EH14-0AB0

Version:3.2.7

B. MGate 5102-PBM-PN:

Firmware Version: V1.2_Build_13083010
GSDML File: GSDML-V2.3-Moxa-MGate-20130708.xml

C. MGate 4101-MB-PBS:

Firmware Version: Ver1.3_Build_14031018
GSD File: MPBS0D80.gsd.

3.2. Software Requirement
A. SIMATIC Step7:

Siemens PLC Engineering Software by Siemens AG.
Version: V5.5+SP3

B. MGate Manager:

Software utility to configure Moxa MGate devices.

Version: 1.10
C. GP-Pro EX:

Screen editor Utility from Pro-face.

Rev.: V3.5

4. Configuration

4.1. Hardware Installation
A. Ethernet Connection

Use Ethernet cables to connect Siemens PLC, MGate 5102-PBM-PN, and
Pro-face GP-4501TW to an Ethernet switch.

B. PROFIBUS Connection
Use a PROFIBUS cable to connect MGate 5102-PBM-PN to MGate

4101-MB-PBS.

4.2. Configuring MGate 5102-PBM-PN
Use MGate Manager to configure the following MGate 5102-PBM-PN settings.
A. PROFINET Setting
Set [Device Name] to "mgate-dev”.
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B. PROBUS Setting
e Add MGate 4101 to the Slave List with the address 3.
e Set the I0 modules as [Slot 1]: “Input 1 Word” and [Slot 2]: “"Output 1
Word”.
4.3. Configuring MGate 4101-MB-PBS
e On the switch, set the PROFIBUS address as 3.
¢ In MGate Manager, set the PROFIBUS 10 on MGate 4101-MB-PBS to [Slot 1]:
“Input 1 Word” and [Slot 2]: “Output 1 Word”.
4.4. Configuring Siemens PLC
4.4.1. Creating a STEP 7 Project
Start SIMATIC Manager and create a new project. Click File > New. Then, set
the project name in the Name field and click OK.

S SIMATIC Manager
File] PLC View Options Window Help

D (228 | | @ W2

Mzer projects |Lihm:ries| Multiprojects |

Name | atorage path -
£9 24slothurndn DAPLCDemn S 7-245 0t 24slotbn. ||
%MDIEUMLEDD DAPLC DermnodS T BuminS Wha 101 Bu_:
%MDIEIUMIQDD DeAPLC DernodS T Bmmdni200% 101 By
%MDIBUMBW DAPLC \Dermon 'S 7 BuminS Wha 101 Burr:
%SIDE C MProgram FilesSiemens\Step?ieTprog
%5102_1024 CAProgram Filesiemens\itepTsToro] —
4| i | 3

[T 444 to corrent solbproject

Hme: Tope:

51024l Iiject LI
[T FLibracy

Eﬁ:urag\ location (path):

ID:".PL;".Demu".SIDZP.C}rc]jJ: Browss.. |

[ ox | Cangel Help |
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4.4.2. Inserting a Station

In SIMATIC Manager, click Insert > Station and select to insert SIMATIC 300
Station into the project.

.:'—,a SIMATIC Manager - 3102Acyclic

Eile Edit F‘I:f_'. View Options Window Help

O = E Station r 1 SIMATIC 400 Station ®

Ep 51024 Subnet vl 2 sMATIC 200 Station

_gm Program [ 3 SIMATIC H Station j
$7 Software N 4 SIMATIC PC Station Ml
S7 Block N 5 Other Station
M7 Software 3 Dalilniis

7 PG/PC

Symbol Table
Teut Library 3

External Source...

4.4.3. Configuring Hardware
A. Adding a Rack
1. In SIMATIC Manager, double-click Hardware.

.'—,a SIMATIC Manager - 5102Acyclic
File Edit Inset PLC View Options Window Help

D& 2@ % B (5 % % T EE 6 Jom
% 5102Acyclic -- DAPLC\Demat3102Acyclich 5310240y c
i Obiject name | Symbolic name |
[l Hardware -
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2. The HW Config screen appears. Click Insert - SIMATIC 300 - RACK
- Rail to insert the rack object.
EEQ HW Config - [SIMATIC 300(1) (Configuration) -- 5102Acyclic]

@l Ststion ;ditELc View Options Window Help
NE &8 §5 sl uln || 1| %8 | h2
!ﬁ'ﬁlPROHBUSDy ‘

2 D OFIHNET ]
SIMATIC 200
[l STH ]

The following figure shows the HW Config screen after adding the rack
object.

E@ HW Config - [SIMATIC 300(1) (Configuration) -- 5102Acyclic]
@l) Station Edit Insert PLC View QOptions Window Help

DEsB S i g | ) %8 w2

=M TR
1 -

m

2
3
F)

.

17 | =

4 L1 2

&so

Slot Module Order number Fiomware | MPI address Taddress () address ComJ
1 -
2

3

4 L
5 =
6

7

3

g -
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B. Adding a CPU

Using Siemens S7-300 PLC to Perform
Acyclic Read and Write on MGate 5102

You must add the appropriate CPU module to the STEP7 project based on the
actual hardware model. In this example, CPU 315-2 PN/DP is the hardware

model.
1.

In the HW Config screen, drag the selected CPU module to the slot table.

DSB8 &

2% HW Config - [SIMATIC 300(1) (Configuration) -- 5102Acyclic]
Bl Station Edit Insert PLC View Options Window Help

s g | h 2R3 (w2

[E=8EoR )

N EES

=0 IR

m_|»

1AQM

17 |

] .

m|»

Eind

olx

Profile:  [Standard

5|

- PROFIEUS-EA

48 PROFINET 10

- SIMATIC 200

fcr

{3 cr-300

= CPU-300

{23 CPIT 312

-0 CHT 312 IRM
{1 crU 313C

{21 CPIT 313
B0 CPU 315C
-0 CPU 313C-2 DP
] CFUT 313C-2 PP
{3 CPU 314

o o

Slot bodule
1

Order number Firmware

ML address

T address Q address Com.

{0 CPU 314 IFM

(] CPU 314C-2 DF
{13 CPU 314C-2 PN/DP
B0 CPU3C2 I
{21 CPU 315

[ e—

(] CPU 3152 DF

\

B0 CPU 315-2 PN/DP

{1 BE87 315-2EG10-04E0

{1 6ES7 315-2EH13-04B0

=] BES7 315-2EH14-04B0

|

[ Vil

T[]

-7 CRIT 3T5R9 P

| | 5| 5] 3] O L) =] o] B3]

o
1

Press F1 to get Help.

PROFIBUS DF slaves for SIMATIC 57, M7, and C7
(istributed rack)

m

il

Chg

The Properties-Ethernet interface PN-IO screen appears.

Click New to add a new subnet as “Ethernet(1)”. Then, click OK.
]

Properties - Ethernet interface PN-IO (RO/52.2)

Configure the IP address and Subnet mask fields for Siemens PLC.

Cepers]  Parameters ]

If a snbnet iz =le

cted,

the next available addresses are sugeested.

] Cratewrayr
IP address: [192.168.32 229 & Do not use ovter
Subnet mask: |255255 2550
" Use router
[ Use different method to obtam IF address Address I—
subnet:
--- not networked ---

Properties...
Delete

0K Camcel |  Help |
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The HW Config screen indicates that the PN-IO interface extends the
“Ethernet(1)"” network in the topology.

% HW Config - [SIMATIC 300(1) (Configuration) -- 5102Acyclic]
E“] Station Edit Insert PLC Miew Options Window Help

D=8 & &

gin s

E =R Vs

- Ethemnet(1): PROFINET-I0-System (100

4 il

Module Order nmmber Firmware | MFPI addrese I address ) addres: (
CFU 315-2 PN/DP 6ES7 315-2EH14-DABO V32 2
MFERDF 2 Eh
FEile EilEn
Foet ! B
Fort2 2044

4.4.4. Installing the GSD file

For engineering and configuration purposes, you must the device’s GSDML file

through SIMATIC Manager.

A. In the HW Config screen, click Options - Install GSD File.

EEQ HWV Config - [SIMATIC 300(1) (Configuration) -- 5102Acyclic]

E“]ﬁtaticm Edit Inset PLC View ﬂindow Help

O = 2~ T g Customize... Ctrl+Al+E
Specify Module...
Configure Metwork
=M UR Symbol Table Ctrl+Alt+T
L Report System Error...
2 CFU 315-2 1
A Edit Catalog Profile
Az o (1007
AR Update Catalog
?H‘E Install HW Updates ...
| Install GSDFile... |
Find in Service & Support...
Create G5D file for I-Device...
o [114
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In the Instll GSD Files screen, click Browse to navigate to the folder and
select the GSDML file for the Moxa PROFINET device. Then, click Install and

Close

Install GSD Files

Install GED Files:

from the divectony

[DAS102EomyGSDML

Install | Show Log

Select All

Demlect 411

Help |

If the GSD file is installed successfully, the system displays Moxa PROFINET
Device in the the hardware catalog list.

o=l

Find: |

#t chi

Profile: | Standard

=

-3 FROFIEUS DF
B2 PROFIBUS-PA

=- %8¢ PROFINET IO

=00 Ldditional Field Devices

El{:l Crateway

-] MGate Fixed

MiFate Generic

E-§a Moxa PROFINET Device
-1 Input modules
B Cutpt modiles

B MJate Sexies
@1 netTAP 100
B2 General

-2 Hetwork Components

-0 Gateway
LT TTRAT
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4.4.5. Configuring the PROFINET IO Device

300 PLC to Perform

Acyclic Read and Write on MGate 5102

In the HW Config screen, select and drag Moxa PROFINET Device from the

hardware catalog list to PROFINET 10 = Additio
the following figure.

=0 UR

CFPU 315-2 PH/DF L
MPEDP i
Piiaie)

Foutd
Fout2

ALY

= Ethernet(l): PROFINE T-I0-System (1000

AZFLR
AZFZR

Ethemet(]}: FROFINET-I0-System (100}

Device Nams | Onder number In.

Tumbes | P addzes. Firnware |Diagmshcadd.ress

Find
Erofile:

DY PROFIENTS DP

nal Field Devices as shown in

| Standard

3% PROFIBUS-PA

52 FROFINET 10

=0 Additional Fisld Devices

{0 Gateway

@ {1 MGat Fived

(1 MGatz Generic

<[ How PROENET Do |
i Input modules
{21 Output modules
| [ 0 Mdat Seriss

i @0 netTAP 100

{2 General

{21 Wetwork Components
77 Cateway

-] HMI

£ 10

The following figure shows the topology with the

£
£
e
-] Wetwork Components
([ Sensors

Moxa PROFINET Device object

graphic.
=0 UR

1 -

2 CPU 315-2 PHN/DF A

Al MEDF 1

o BV - Ethernet(1): PROFINET-I0-Systen (100)
ER Foct !

LER FortZ

3 -
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You can double-click “(1)maget-dev” of Moxa PROFINET Device object to
configure its properties.

Properties - mgate-dev &J
Creneral ]
Short description: mgate-dew
(Moxa Gateway) PROFINET IOPROFIETE-DE Cratewary Device p

Order no.f fimware: MGate-FNIO V1 2
Farmily: MGate Generic

Device name:

3D e GSDML-V2 3-Maxa- MGate-20130518 3anl
Chenge Feleass Number. .. |
Hode in FROFINET IO system
Device number: 1 - [PROFINET-10-System (100;

[P address: 192.168.32.230 Ethemet...

v Btz [P address via [0 controller

Comment:
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4.4.6. Configuring I/0 Modules

You can configure the selected I/O modules for data exchange with Siemens PLC.
You can select the I/O module combinations based on your application. This
example uses the Input 2 Byte and Output 2 Byte IO combination.

A.

Device to slot 1.

DOUR

T
7
bl

Drag the Output 002 Byte module to slot 2.
Save the changes.

Drag the Input 002 Byte module from the module list for Moxa PROFINET

Profile:  [Standand

8FPROFIBUS DP =
A8 PROFIBUS-PA

pel BYID - Ethemet(1): PROFINET IO Syctem (100) 8 PROFINET IO
QAR Fort 1 Y &40 Additional Field Devices
2R ; FortZ Goteway
El d @ et {20 MGate Fond
{1 MGate Generic
- Mox PROFINET Device
10 Tnput modules
=+ Output modules
Quiput0] Byt
Gty 107 Byt
g [
e O B
Ouiputil4 Eyte
| O metdoy e
Stot Moduls Ordermumber | Tofdrss | Qoddess | Dingaostic afdress: Comment Ouiput 006 Eyie
0 |g meate-der [MGate-Pre0 [z0¢z: Outputi? Eye
x [[§ meio [zor= Output06 Byt
1 {{ Forel Outptid Byt
A |f P [aozo~ Outputil 0 Eye
1 Trput 007 Byte B35 Outputnt 1 Byt

3

Output 012 Byte

Ol

-[§ Ouputnt3 By
Output 014 Byte

4.5. Configuring Siemens PLC Acyclic Read/Write Operation
4.5.1. Inserting Data Block

You must first add data blocks to configure request and response parameters.

A.

add data blocks.

In the SIMATIC Manager screen, click Insert ©> S7 Block - Data Block to

.'—,a SIMATIC Manager - [3102Acyclic -- DAPLC\Demo\3102Acyclich5102Acyc]

2D Fle Edit PLC View Options
= %? , Station 3
E--% 51024cye Subnet 3
EHE SIMA Proar .
: grar
=@
ERED 57 Software 3
| [ s7elock y
M7 Software 3
Symbol Table
Text Library »

wternal Source...

Window Help

8, % BB
B e

| « Ho Filter =

=

| Synbolic mamme

| Created i langnage

1 Organization Block
2 Function Block

3 Function

5 Data Type

6 Variable Table
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In the Properties screen, configure the fields and click OK to create two data

blocks. Enter the field values as listed in the following table.

Name DB1 DB2
Symbolic Name DB_Request DB_Response
Properties - Data Block Lﬁ
Grenersl - Part 1 | Generol - Part2 | Colls | Attributes |
Name and type; |TE1 | Shared DB 1| =]
Symbolic Name: ﬁ)B_Request I
Symbol Comment: |
Created in Language: LE hd
Prodect path; [
E'f”fr‘ogjiﬁcmn [D7PLC Demo'5 102 Acyclic5102Acye
Code Interface
Diate created: 02/01/2014 02:15:17 PM
Last modified 03/01/2014 02:15:17 PM 08M01/2014 02:15:17 PM
Conunent; !
Coce_|_top_|
Properties - Data Block LX)
Genersl - Part 1 | General - Part2 | Calls | Attributes |
Hame and type: |DE2 [$hared DB =1 =
Symbolic Name: I |DB_Resp0nse I
Sambol Comoment: |
Created in Language: DE hd
Project path: |
S locatio
ofprmect [DPLC Deme'5 102 Acyelie 510240y
Code Interface
Date created: 02101/2014 02:16:20 FM
Last modified: 02101/2014 02:16:20 FM 08/M01/2014 02:16:20 P
Comment: L
Cussl_|__ il

Copyright © 2014 Moxa Inc.
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4.5.2. Copying SFB52 and SFB53

SFB52 and SFB53 function blocks are used for read and write requests on
Siemens PLC.

Complete the following steps to copy these function blocks to your project:

A. Inthe SIMATIC Manager screen, click File > Open and click the Library tab.

B. Select Standard Library and click OK to open the pre-defined library.

-

Open Project

=2

st projects | Libraries

ample projects | Multiprojects |

o]

Cancel

Wame | Storage path -
2 Additionel Modbus Blocks DAPLCVETRME
2 Redundant [0 CGP V40 CA\Program File
&2 Redundant [0 COP V52 C\Program File| =
2 Redundant [0 MOP 732 CAProgram File
A b P CoWProgram Filel
WP rogram File
s : ! CAPvreramn File T
i | 1] 3
Selected

Tzer projects:

Libraries: 1

Sample projects:

Multiprojects: Browse... |

Help

L

C. From the Standard Library tree view, click System Function Blocks >

Blocks.

D. On the right panel, select SFB52 and SFB53 and click Copy to copy them to

your projects.

& SIMATIC Manager - [Standard Library - C:\Program Files\Siemens\Step7\S7libs\stdlib30]

File Edit Insert PLC View Options Window Hel
p p

O af & & 2 2p < Mo Filtsr » - B EM R
B4 Standard Library Cbject name | Symbolic nams | Created in language | Size in the work me... | Type | Version Header) | Mome (Header)
Communication Elocks | g3 $FB43 FULSEGEN 1L — Systom function block. 1.0 FULSEGEN
IEC Function Blocks &3 SFB44 ANALOG STL —- System function block 1.0 ANALOG
Miscellaneos Blocks | 3 sFR4g DIGITAL STL - System function block 1.0 DIGITAL
Organization Blocks 53 SFB47 COUNT ST - System fonction block 1.0 COUNT
FID Control Elocks 43 TFRAS FREQUENC aTL - Systern funstion Block 10 FREQUENC
E-G7) PROFlenergy Blocks | oy PULSE STL - Systom function block 1.0 FULSE
erting Blocks RDREC Sortens freetin Gk
WRREC Open Object Cul+Alt+O
Eyz:] RALEH ck 10 RALRM
53 SFBS0 SEND_PTP Cut CleX g qp SEND_PTP
43 SFBSL RCY_PTP Copy ctl+C ok 10 RCY_PTP
&3 SFBE2 RES_RCYE SIL o Coley [k 10 RES_RCYE
&3 SFES3 SEND_RK SIL ek 10 SEND_RK
&3 SFEG4 FETCH_RK SIL Delete Del [k 10 FETCH_RK
&3 SFESS SERVE_RK 1L ck 10 SERVE_RK
&3 SFB73 RCVREC STL Insert New Object Pk 10 RCVREC
53 SFEM FRVREC 210 c — ck 10 FRVREC
43 SFETS SALEM 2TL ampare Sloc ck 10 SALRM
53 8FBSL RD_DPAR 210 . , k10 RD_DPAR
53 $FB104 IF_CONF 211 ch 10 IF_CONF
53 SFCD SET_CLE 1L Special Object Properties » 10 SET_CLE
RO RFAT CTE [T imn RFaT CTE

Copyright © 2014 Moxa Inc.
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Using Siemens S7-300 PLC to Perform
Acyclic Read and Write on MGate 5102

SFB53 Instance DB

Add two data blocks for SFB52 and SFB53. To create the data blocks, configure
the fields in the Properties — Data Block screen as shown in the following

table.

Name and type

Symbolic Name

DB52

Instance DB
SFB52
SFB52_Instance

DB53

Instance DB
SFB53
SFB53_Instance

For more information on accessing the Properties — Data Block screen, see the
Inserting Data Block section.

The following figures show the Properties — Data Block screen.

Properties - Data Block

|

General - Paut 1 | Genersl - Part2 | Calls | Attributes |

Heme and type: DB (nstnce DB v | |SFES2 -1l

N |W =

Symbiol Comment: |

Created in Language:  [DE -l

Froject path; |

Eﬂﬁfﬁﬁmﬁ”n [DPLC Demo's 102 heyelirs1 02 Aoye

Code Interface

Date created: 08/01/2014 02:25:03 PM

Last modified: 08/01/2014 02:25:03 PM 08M01/2014 02:25:03 FM

Cormment: "
Cancel Help

Copyright © 2014 Moxa Inc.
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Properties - Data Block S

General - Paut 1 | Genersl - Part2 | Calls | Attributes |

Mare and type: DBE&3 |Ins1}sme LE - | |BFB5: -
Symbolic Name: |SFBE3_Tnstance
Symbiol Comment: |
Created in Language:  [DE -l
Froject path; |
Sto locatio
ofproect [DPLC Demo's 102 heyelirs1 02 Aoye
Code Interface
Diate created : 030152014 02:26:54 PR
Last modified : 030152014 02:26:54 PR 03012014 02:26:54 P
Comoment; n

After adding the two data blocks, the SIMATIC Manager displays the entries as
shown in the following figure.

& SIMATIC Manager - [5102Acyclic -- DAPLC\Dema\5102Acyclic\5102Acyc]
&9 Fle Edit Inset PLC Wiew Options Window Help

D& 3@ g | 2 %5 % L « Ho Filler » 1 EE BEDIN
£ 5102hcyche Object nams | Symbolic nsme | Created inlangmage | Size in the work me... | Type | Version (Header) | Name (Header) | Un
-] SIMATIC 300(1) @smmdmﬁ - - 2DB — - —
=-[§] CPU3LS-ZENDP | moB1 28 OrganizsfionBlock 0.1
0 $7Pmgrmll) |5 ppy DB_Request DB 38 DataBlock 01
(I Sources ©DB2 DE_Response DE 3 Dot Elock o1
£ Blocks @ DES2 SFE52_Instance DB 64 Instunce datablock £ 0.1
o bE SFEES Tnchnee BE 68" Tustoace dae. black 4., 0.1
o SFESZ RDREC i — " System function block 1.0 RDREC
&3 SFBS3 WEREC STL === Systemn function block 1.0 WEREC

4.5.4. Configuring DB1

Click the DB1 data block to configure the structure variable as shown in the
following figure.

Address Name Type Initial value Commen t
0. STRUCT
+0.0 |Ccmic1“'crdB}'tel BYTE B#16%0
+1.0 |Ccmrc1WCIdB}'IEZ BYTE B#164#0
(| =2.0 FND_STRUCT

Copyright © 2014 Moxa Inc. Page 16 of 36
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4.5.5. Configuring DB2

Using Siemens S7-300 PLC to Perform
Acyclic Read and Write on MGate 5102

Click the DB2 data block to configure the structure variable as shown in the

following figure.

Address Name Type Initial value Comment
0.0 STRUCT

+0.0| [StatusWordBytel BYTE B#1620 I
+1.0| (StatusWordByte2 BYIE BH#16#0 1:8top, 2: Clear, 3: Operate
12.0| |SlaveD00007 EYTE B#16%0 Slave 0-7
43.0| |SlaveDDR0O1S EYTE B#16%0 Slave 8-13
+4.0| |Slave016023 EYTE B#16#0 Slave 16~23
+5.0| |Slave024031 BYTE B#1620 Slave 24-31
+6.0| |Slaved32039 EYIE B#16£0 Slave 32~-39
+7.0| |Slave040047 BYTE B#1620 Slave 40-47
+8.0| |SlaveD4B055 EYIE B#L16E0 Slave 48~55
+9.0| [Slave056063 BYTE B&16#0 Slave 56~A3
+10.0| (Slave064071 BYTE B21620 Slave 64~71
+11.0| (S1ave072079 BYTE B#16£0 Slave 72-79
+12.0| (S1ave0BOORTY EYTE B#16%0 Slave 80-87
+13.0| [Slave0BB095 EYTE B#16#0 Slave 2805
+14.0| |Slave096103 BYTE B#1620 Slave 96~103
+15.0| |SlavelD4ll1l EYIE B#16£0 Slave 104~111
+16.0] Slavell2lld EYIE B#16£0 Slave 112~119
+17.0| |Slavel20125 BYTE B#1620 Slave 120~125
=18.0 END_STRUCT

4.5.6. Programing Acyclic Read to MGate to set getting Status Word

A. Insert Network 2 to program Read Status Word.
B. Under SFB blocks, drag SFB52 to Network 2 and configure the input and
output parameters as shown in the following figure.

-1 Bit logic

E|C{| Comparator
3@ Canverter
E| Counter

#1-{58] DE call

3@ Jumps

3{?_f| Integer function
E| Floating-point fct.
E| Maove

3@ Pragram control
E| Shift/Rotate
E| Status bits
3@ Timers

3@ Word lagic
388 FB blacks

388 FC blocks

3./ SFB blacks

-

m

189 SFC blocks

I-CI' SFBE52 RDREC DPl

..... iF SFBS3 WRREC DP

system function blocks

£

=] m: Read Status Word

B52
"EFRSZ_
Instance"
SFB52
Read a Process
Data Record
/ "RIREC" Mi.0
EN EMO —R—
AI.D—REQ TALID  |-HW1.1
IW#16#7F9 Q10 BUSY  LM1.2
1024 — INIEX ERROR  |-M1.2
2 _{MLEN STATUS  L-MD10
P#DEZ . LEN |-
DEX0.0
BYTE 2 {RECORD

F Metwnrk 3 - Bead Conmnnication Tist
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The following describes the parameters.

REQ: The Read request is sent to MGate 5102-PBM-PN using bit memory
M1.0. Enter 1 (true) to start the read request. The request should then
be ended. Enter 0 (false) to end the request. A Reset Bit logic is used to
reset M1.0.

VALID: Bit memory M1.1 indicates whether a new data record was
received and valid.

BUSY: Bit memory M1.2 indicates whether the read process is
terminated or not.

ERROR: Bit memory M1.3 indicates whether an error has occurred while
processing the function.

STATUS: The double-word bit memory MD10 contains an error code. For
error descriptions, see "Help on system functions / function blocks".
ID: The PN-IO diagnostic address (for example, "2041"”). This address is
used for PROFINET acyclic read/write to MGate5102-PBM-PN to perform
pre-defined diagnoses.

INDEX: Data record number. For MGate5102-PBM-PN Status Word, the
starting address is 1024.

MLEN: Maximum length in bytes of the data record information to be
fetched. For MGate5102-PBM-PN Status Word, the length is 2 bytes.
RECORD: Destination area for the read data record. For DB 2 in this
example, the starting address is 0 and the address length is 2 bytes.
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4.5.7. Programing Acyclic Read to MGate to Get the Communication List

B

b

£

[

@1 Counter "SFBSZ

E-{28) DB call Instance"

E{E] Jumps SFB52

[@-{=1 Integer function Read a Process

-z Floating-point fct. / Da};ngigerd We 0
EHz Move ] END

@38 Program control /

5139 Shift/Rotate » M2 .0 REQ VALID M2
-3 Status bits 1 DW#1647F9 {10 MY | H2.2
B Timers
-2 Word logic 1026 JINIEX ERROR  |-M2.3
@-{£H FB blocks

E-{gH FC blocks

28 SFB blocks P#DBZ. LEN ...

7Ll SFC blocks i

.. Bit logi -
i CI ogie " Em: Read Communication List
= omparator

1-{2g Converter

IB52

R -

m

16 —-|MLEN STATUR  |-HWD10

g...DSFBsz RDREC DP gﬁ%?ﬁ RECORD
"% SFBS3 WRREC DP i

System function blocks e

The following describes the parameters.

REQ: The Read request is sent to MGate 5102-PBM-PN using bit memory
M2.0. Enter 1 (true) to start the read request. The request should then be
ended. Send a value of 0 (false) to end the request. A Reset Bit logic is used
to reset M2.0.

VALID: Bit memory M2.1 indicates whether a new data record has been
received and valid.

BUSY: Bit memory M2.2 indicates whether the read process is terminated or
not.

ERROR: Bit memory M2.3 indicates whether an error has occurred while
processing the function.

STATUS: The double-word bit memory MD10 contains an error code. For
error descriptions, see "Help on system functions / function blocks".

ID: The PN-IO diagnostic address (for example, *2041”). This address is
used for PROFINET acyclic read/write to MGate5102-PBM-PN to perform
pre-defined diagnoses.

INDEX: Data record number. For MGate5102-PBM-PN Status Word, the
starting address is 1024.

MLEN: Maximum length in bytes of the data record information to be
fetched. For MGate5102-PBM-PN Communication List, the length is 16
bytes.

RECORD: Destination area for the read data record. For DB 2 in this
example, the starting address is 2 and the address length is 16 bytes.
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4.5.8. Programing Acyclic Write to MGate 5102-PBM-PN to Set Control Word
In SIMATIC Manager, double-click OB1 under S7 Program - Blocks. The OB1
block is a Program Cycle Organization Block. The operating system of the S7
CPU executes OB1 periodically. When OB1 has been executed, the operating
system starts it again. Cyclic execution of OB1 is started after the startup has

been completed.

A. Click OB1 to edit the program.

B. Insert Network

1 to program Write Control Word.

C. Under SFB blocks, drag SFB53 to Network 1 and configure the input and
output parameters as shown in the following figure.

-3 Bit logic

%] Comparator
-85 Converter
-1 Counter

[-{o8] DB call

-5 Jumps

E-{z0 Integer function
[-{z8 Floating-point fct.
-z Move

@36 Program control
-z Shift/Rotate
m-fig Status bits
(@] Timers

-2 Word logic
-{£8 FB blocks

R FC blocks

=-{£8 SFB blocks

.0} SFBS2 RDREC DP

n 0Bl : "Main Program Sweep (Cvcle)"

Em:'ﬁ'rite Control Word

IB53
"SFBS3_
Instance"
SFB53
Write a Process

Data Record
“WRREC"

m

HO.0
—ir—
Lo 1

/EN
/

IW#16#7F9 1D

ENO

HO .0 REQ DONE

BUSY  (-HO.2

1024 - INDEX ERRCR |02

/ |

2 LEN STATUS  -HDI1OD

E-H SFC blocks

P#DB1.

System function blocks

DEX0.0
EYTE 2 RECORD

%

] TP Program elements | B= Call structure | 5= Netwarks |

The following describes the parameters.

o REQ: The write request ("Write parameter") is sent to MGate
5102-PBM-PN using bit memory M0.0. Enter 1 (true) to start the write
request. The request should then be ended. Send a value of 0 (false) to
end the request. A Reset Bit logic is used to reset M0.0.

o DONE: Bit memory MO0.1 indicates whether a data record has been

transferred.

o BUSY: Bit memory MO0.2 indicates whether the write process is

terminated or not.

ERROR: Bit memory MO.3 indicates whether an error has occurred while
processing the function.

STATUS: The double-word bit memory MD10 contains an error code. For
error descriptions, see "Help on system functions / function blocks".
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ID: The PN-IO diagnostic address (for example, "2041"” as shown in the
following figure). This address is used for PROFINET acyclic read/write
on MGate5102-PBM-PN to perform pre-defined diagnoses.

INDEX: Data record number. For MGate5102-PBM-PN Control Word, the
starting address is 1024.

LEN: Length of the fetched data record information. For
MGate5102-PBM-PN Control Word in this example, the length is 2 bytes.
RECORD: Write Out Data Record. For DB 1, the starting address is 0 and
the address length is 2 bytes.

=0 UR
1 - Ethemet(l): FROFINET-I0-8xystem (100}
2 CPU 315-2 PN/DP L
A MEDF 3
Az AR
AIFPIR Fost i
fZ}?H Fort 2 R B ) mzte-d
4 . /
tlzl (1) mgate-dev

Order mumber

4 Toput 002 Eyte 256 057
[{ Output 002 Byte 256,257
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4.6. Creating the Variable Table

In the variable table, you can modify and monitor the connected PLC variables
and memory content.

To insert a variable table in the SIMATIC Manager screen, click Insert - S7
Block > Variable Table.

Add the variables as shown in the following figure and save the changes.

ﬁ Var - [VAT_1 - 5102, lich SIMATIC 300(1\CPU 315-2 PM/DP\ST Program(1]]
g
K3 Table Edit Insert PLC Variable View Options Window Help

#| D|e(E| S| % [%(@[o|~| X| 2=[2] M| o] &[] o
A

| Adduess | Srmbal | Th=play forrmt| Status value | Tuladify value
T | Wit "Contol Word” Request Trigeer
7 T TR BOOL
3| Read St Word® Reauest Tagger :
IOMTeTTT BOOL
T iR rmnication [ist Bequest Trigeer :
8] M i BOOL
T s Word :
8| DBEIDEW 0 VHEX
| el W :
] DEIDEW O CHEX
| emmmvmicaton L5t :
1z| [OEIDEE T DB Besponse” Slave0o0007 HEX
| DELDBEE 3 DB Response’ Slae00801 5 HEY
14| | DBIDBE 4 "DB_Response’ SlaveOl6023 HEX
G| DBIDBE 5 DB Respense’ She 401 HEY
6] DEIDEE & DB Respense Slaved3inag HEY
7| DBIDEE 7 DB Respense Slaveca(id7 HEY
15| DBIDBE 8 "DB_Response’ Slave0d8055 HEX
B HBIDBE 9 HE Respense’ Sho0sE063 HEY
Z|  DEIDEE 107 "DE Response’ Slive0d071 HEY
2| DBIDEE 11 DB Besponse” Slae(73070 HEY
Z|  DBIDEE 12 DE Response” Slave080087 HEY
T| DBIDEE 13 DB Besponse” Slave0sa068 HEY
2| DBIDEE 14 DB Besponse’ live086103 HEY
Z| DBIDEE 15 DB Response’ Sliveltdiil HEY
Z|  DBIDEE 167 "DE Response” Slavel 17116 HEY
7| DBIDEE 17 DB Bespense: lavel 20125 HEY
.
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4.7. Downloading a Project to PLC
In the SIMATIC Manager screen, click the Download to Module icon to
download the configuration to CPU 315-2 PN/DP.

# SIMATIC Manager - [5102Acyclic -- D\PLC\Dema)\5102Acyclic\5102Acyc]
% File Edit Insert PLC View Options Window Help

D 87F & BiI |2 F fo - EEE | < No Filter = 2
=8 i / Cibject name | Symbolic narme | Tupe
C 300(1} @l Hand e -- Station configuration
F FIIDE CPU 3152 PHDP o i
=-{z1 87 Program(l)

-{Bl Sources

{3 Blocks
Select Node Address ﬁ

Ower which station address is the programming device connectad to the module CPU 215-2 PN/DE?

Eack: ] EI
Slot: 2 EI
Target Station: ]
~
Enter connection to target station:
IP address MAC address Module type | Station name | Module name
192.168.32.229 00-1B-1B-57-C8-.. CPU 315-2.. SIMATIC 30.. CPU 315-2 ..
a4 LI [
| Accessible Nodes

192.168.32.220 00-1B-1B-57-C8-30 CPU315-2P.. SIMATIC30.. CPU313-2F..

CK Cancel Help

PLC starting communicating with MGate 5102-PBM-PN. The PN Status
(PROFINET) LED on MGate 5102-PBM-PN turns steady green which indicates
that the PROFINET status of the device is in RUN mode.
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4.8. Configuring GP- Pro EX
4.8.1. Creating a New project
A. Start the GP-Pro EX application.
B. The Welcome to GP-Pro EX window appears. Select New and click OK.

= Welcome ta GP-Pro EX (e |

@oﬁﬁsﬁ

() Create Project From Sample
Active_Alam_Detail_Block prc -
Alarm_History_Display prc D
EZ_Tower_Light_QVGEA prx
EZ_Tower_Light_VGA prx i
() Open Existing Project

() Open Recent Project

MNative Test pre -
Control Logi prc D
S7Demo prc

450test prc &

|| oK) || Cancel

C. Configure the following Display Unit settings and click Next.
e Series: Select GP 4000 Series and GP-45** Series from the
drop-down lists.
¢ Model: Select GP-4501TW from the drop-down list.

& Welcome to GP-Pro EX (e |
Display Unit
Series GP4000 Series -]
GP-45~ Series -
Model EXEn -
Orientation | Landscape hd
Specifications
Screen Size 10.4inch
Resolution 640 x 480 pixels (VGA)
Display Unit TFT Color LCD
Display Colors 65,536 Colors
Touch Panel Analog
Internal Memory 16 MB
Backup Memory 128 KB
COM1 RS-232C
Ccomz RS5-422(RS-485)
USB(&) 1 Ports
USB({mini-B) 1 Ports
LAN 1 Ports
sD On
Video Input Mone
Internal Board None
—
[ Back® ]| Mea® ]| Cancel
e——
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D. In the Device/PLC screen, configure the following fields and click New
Screen:
e Manufacture: Select Siemens AG from the drop-down list.
e Series: Select SIMATIC S7 Ethernet from the drop-down list.
e Port: Select Ethernet (TCP) from the drop down list.

&= Welcome to GP-Pro EX - - - X
Device/PLC
Number of Devices/PLCs 1 <=
DevicelPLC |
Manufacturer | Siemens AG E
Series SIMATIC 57 Ethernet E
Port | Ethemet (TCP) -]
FETer o the manual of this Device/ LT
Becent Device/PLC
}

Use System Area Device Information

| Back () || Communication Settings | | New Logic ||[ MNew Screen ]I Cancel |

The system closes the Welcome screen and creates a Base Screen as
shown in the following figure.

Screen List 2 x|| 5 Base 1(Untitled) £ |

Screensof Type (A1 -

=

SearchMethod  [Tide -]

Refine Search

HOBX| 2&%

3 Base Screens

BO0O1

{3 Window Screens

3 Keypad screen

INIT

MAIN

= |8 Color| 28 Scree

4.8.2. PLC Connection Setup

A. Click the Project tab and select Device/PLC.

B. In the Device/PLC 1 configuration area, click the icon next to PLC1 as
indicated in the following figure.
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Project \Window 1 x|| B Esse i(United) (3 El System B
| & Device/PLC
& E ;ﬂ;"' ?E“‘HDS - fdd Device/PLC  Delete Device/PLC
= isplay —|
{3 Display Device/FLC 1
{3 Display Unit Summary Change Device/PLC
17 Logic P
:E:% \/‘\dg;‘;/l\;oo%zms Manufacturer  Siemens AG Series  SIMATIC 57 Ethemet Fort  Ethemet {TCF)
{EF Fort E Text Data Mode 1 Change
B8 Peripheral Settings
...[F Peripheral |ist Communication Settings

a ¢ |2 EHlE PortNo. (FETCH) [1024 7 Auto
gy Prnter
62 Input Equ.p&r« L] (WRITE) (1025

y5 Seriot Timeout 3 (sec)

@ /0 Driver
0
-

L, FTP Server
Add Device

S| (| (B[

- Modem
- Image Unit
(=[] Commen Settings

g Alam

=g Sampling

1l Sampling Grpup List Settings Add Indirect

Enhanced Recife seftings g Device
Enhanced Hecipe Group List &1 P PLC Type=57-300/400 Series Device Names=Fnglish
= Recipes

No. Device Hame

C. In the PCI settings screen, configure the following fields and click New:
e Destination IP Address: Enter the IP address.
e Connection Type: Select OP Communication from the drop-down list.
e CPU Rack Number: Enter “0".
e CPU Slot Number: Enter “2”.
e Use Tag Data: Select this check box.

& Individual Device Settings LX)

PLC1

PLC Type 57-300/400 Series -

Device Names i@ English (™) German
(If you change "FLC Type™ or "Device Names”™,
please reconfirm all address settings |

Destination |P Address 152 168, 32 225

Connection Type P Communication -

CPU Rack Mumber 0 =

CPU Slot Number 2 o
Tag Data

[ ok@©) || Ccancel |

Copyright © 2014 Moxa Inc. Page 26 of 36




Using Siemens S7-300 PLC to Perform

Moxa Tech Note Acyclic Read and Write on MGate 5102

D. The Add Tag screen appears. Click Import.
f Tag List — — - =HEC &1
Tag Data Name
Diata type [<.NI> - Usage
Tag | Datatype
MName Data type Address Comment
e ] e
( OK | [ Cancel |

E. In the Tag Import screen, select DB_Request and DB_Response; then,

click OK.
Tag Import =NACE X
SelectFile  D:APLC\Demo“5102Acyclict5102Acyc 510240y s7p Browse...
Tag | Datatype
Name Data type Address Comment
DB_Request | DB_Request DBO0001.DEBOOODD
DB Responﬁe DE_Response DBO00D02.DBEODDDD
[T SFB52_lnstance SFB52_Instance DBO0052. DEX00000.0
[[]  SFB53_Instance 5FB53_Instance DBO0053.DEX00000.0
Select Unselect Select Al Unselect All
Log File C:\Users\general_chiang\Documents'\201481-F<F 030931 html
( 0K | [ Cancel
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F. In the Tag List screen, click Add to add the BOOL tags as shown in the

following figure.

= ~
Tag List [E=EN =X
Tag Data Name  TagDatalil
Diata type |=AII> - Usage |<All> v| | Update |
Tag | Datatype
MName Data type Address Comment
I CommunicationList Tigger BOOL MDD002.0
1 CortrolWord Tigger BOOL MOD000.0|
DB_Request DB_Request DBO0001.DBEOOD00
DE_Response DB_Response DEO0002. DBEBO000D
IStatus‘.'Vor\:ITrigger BOOL MD0001.0 I
Import | | Export aod |
( oK ] [ Cancel
L |

Create a new Screen and insert the parts as shown in the following figure.

Control Hord

Status Hord

Communication List

Slave @~7 1 Slave 32~33
l

Slave 8™~15 | Slave 40™~47

Slave 16~Z23 | 1 Slave 43“55| 1

Slave 24~31 | | Slave 5663 | |

Input Control Hord

Output Status Hord

Slave 64™71| | Slave 36~1@3 |
Slave 72~79| | Slave 1B4~111
Slave BB”B?| 1 Slave 112”115| 1

Slave 88~35| | Slave 120™125| |
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The following figure shows a Control Word/Status Word input box example.

== Switch/Lamp ]
Parts D Switch Feature | Switch Common | Lamp Feature | Color | Label |
z
Comment Switch Feature — — T
Multi-function List % % %l % @
b ‘wiord Se Special Sel
T rlon reen pecia ector
1 Bit Switch g fich  Change  Switch  Switch
Bit Address ==Extended
- | IPLC 1)Control Word Tigge: ~
Mormal Copy from Lamp Copy to Lamp
Cir_0005M_17G__ Bit Action
Select Shape | Bt et - I
[] Ne Shape
Delete
[] Include in Operatien Log
Help (H) [ okiop || Cancel
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The following figure shows a Control Word/Status Word input box example.

i Data Display S|
Farts |D Basic | Display | Color/Alamm | Operation Process | Data Entry |
DD _0000 = Display Data
& 1 e A [
Mumeric Text Date/Time Statistical Show Limit Input Display
Display Display Display Data Display  Walue
e W A ==Extended
[PLC1]DB_Request ControlV |A1|cm|nput |
DataDisp_0003M... [7] Scaling Settings
Select Shape
[F] No Shape Data Type |8 Bit Dec ~| [ Sign+- Round Off
[ Include in Operation Log
Help (H) [ ok ][ Cancel
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The following figure shows a Communication List input box example.

i Data Display (eS|
Parts 1D Basic | Display | Color/Alam | Opertion Process |
DD_0o02 = Display Data
= 14 b E B8
Mumeric Text Date/Time Statistical Show Limit Input Display
Display Display Display Data Display  Walue
ARG
ABL ==Extended
B Response.Slave 10000 7R [ Mlow Input
DataDisp_0003M... [7] Scaling Settings
Select Shape
[F] No Shape Data Type | |8 Bit Dec ~| | [0 Sign+- Round Off
Include in Operation Log
Help {H) [ ok ][ Ccancel
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5. Communication Test

5.1. Performing HMI Test
5.1.1. Write Control Word Test

A. Login to the MGate 5102-PBM-PN web console. Click System Management
- Maintenance > PROFIBUS Control and change the switch operation
mode to Stop.

B. In the HMI panel, select the Input Control Word input box and enter 3 on
pop-up keypad.

Control Word

Status Word

Communication List

Slave 0“7 Slave 32~39

Slave 8“1S5 Slave 40~47

Slave 1623 Slave 4855 Slave 8087 [| Slave 112™119

Slave 24~31 Slave 56~63 Slave 8895 [] Slave 120125

C. In the HMI panel, click Control Word Trigger to set Siemens PLC to send
Acyclic Write Command to MGate 5102-PBM-PN.

D. Log in to the MGate 5102-PBM-PN web console. Click System Management
- Maintenance = PROFIBUS Control, the status for the operation mode
is Operate.

5.1.2. Read Status Word Test
After Test A (Write Control Word Test), click Status Word Trigger to set
Siemens PLC to send Acyclic Read Command to MGate 5102-PBM-PN. The value
for the Status Word input box value is updated to 3.
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5.1.3. Read Communication List Test
After Test B (Read Status Word Test), click Communication List Trigger to
set Siemens PLC to send Acyclic Read Command to MGate 5102-PBM-PN. The
values for Slave 0~7 input boxes should be updated to 8 to indicate that MGate
5102-PBM-PN is exchanging datat (“"Data_Exchange”) with PROFIBUS Slave (at
address “3").

rol/Status Woi

Control Word @ Input Control Word
Output Status Word

Status Word

Communication List O

Slave 07 Slave 32~39 Slave 64~71| [| = Slave 96183

List

Slave 815 Slave 4047 Slave 72~79 Slave 104™111

Slave 16~23 Slave 48™55 " Slave 80“87 | Slave 112™119

Slave 2431 Slave 5663 Slave 88~95 [ Slave 120125
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5.2. Using the Variable Table

Open the VAT_1 variable table and click the Monitor icon to connect PLC to the

monitor variables.

K2 \ar - [VAT_1 -- @5102Acyclic\SIMATIC 300(1)\CPU 315-2 PN/DP\ST Program(1) OMNLINE]
K2 Table Edit Insert PLC Variable View Options Window Help

4| Dlsla| 8| 4[ele]o|o| x| [ 8] x| el o] w

| Address Earmnbal | Dhisplay fm‘rrﬂt| Btatus value | Tofodify value
1] [Toe Conec Word Request Trigzer
Z| M 00 BOOL i e
3| e “Sats Word” Boquest Trizeer
oM BOOL i fee
T R Cmmmniration LSt Beqnest TAgeer
Bl M 20 HOOL g false
T s Werd
| DELDEW 0 VHEX TG0
T ontol Word : '
M| DEIDEW ¢ VHEX WH GO0
M| i mmmmmication |5t : '
12| DELIDBE 1 DE Response’ Shvel00007 HEX B 6400
3| DBIDEE 1 DB Response Slavel08013 HEX BH#L6H00
@ DBIDEE 4 DB Resporse Slavell 6003 HEX Bi16#00
5| DBIDEE 3 DB Resporse” Slaveldatsi HEX B#6#00
8] DBIDEE & Db Resporse Slaveldioss HEX B#6#00
7| DEIDBE 7 DB Response’ Slaveid00d7 HEX B 6400
| DBIDEE § DB Response” Slaved 8053 HEX BH#L6H00
5] DBIDEE 9 DB Resporse SlavelS6063 HEX BH#L6H00
| DEIDEE 10 "DE Response” Slave0Bd071 HEX Bi16#00
2| DEIDEE 11 "DE Response" Save(i7ios HEX B#6#00
Z| DEIDEE 13 "DE Response" Save0io0s7 HEX B#6#00
| DEIDEE 13 "DB Response” Slave08R008 HEX B 6400
2| DEIDEE 14 "DB Response” Slave006103 HEX BH#L6H00
F|  DEIDEE 15 DB Response’ Slavel 4111 HEX B#16H00
Z| DEIDEE 16 "DB Response" Slavel 13116 HEX Bi16#00
7| DEZDEE 17 "DE Response” Slavel 20175 HEX B#6#00
22

5.2.1. Write Control Word Test

A. Login tothe MGate 5102-PBM-PN web console. Click System Management
- Maintenance = PROFIBUS Control and change the operation mode to

Stop.
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B. Inthe VAT_1 variable table, set DB1.DBW 0 to W#16#0003 and click the
Active Modify Value icon. The value for the DB1.DBW 0 status value
should be updated to W#16#0003.

Var - [VAT_1 -- @5102 [I\SIMATIC 300(1{CPU 315-2 PN/DPAST Pragram(1) OMLIME]
9
K2 Tsble Edit Insert PLC Variable View Options Window Help

J D||e| S| &[8[@]o|| X|[% 2| || Y v fﬂ“ﬂ

E Addiess | Syrmbol | Thsplay ﬁ:cfmat| Btatus value
T /Wi Control Word” Request Tigzes
7| M A BOOL g e
31 FRead “Stabes Word® Bequest Trigas:
M 10 BOOL g flse
S R Emnmnmiration Lt Bt Trigas:
GRS T BOOL™ g e
7L s Wond
8| DEADEW 0 CHEX C WHGH
5 e Wend : : o
0| MR T WHIGH000 W BH0003
11 | 7 omrmamiration List
2| DB2DEB 2 | "DE_Response’ Slaveb0000 HEX  B#IGHD

C. Set M 0.0 to true and click the Active Modify Value icon. This sets Siemens
PLC to send Acyclic Write Command to MGate 5102-PBM-PN.

K8 Table Edit Insert PLC Variable View Options Window Help

J D[ |d| & & |®l@o]| X[ 8| W] Do @] 5|4 bl

E Addzess | SByrbol | Dhisplay furrmt| Status value | ifyr value
T [ Wit "Contol Word” Request Trigees \
2 : : :BOCL
3 [ e St Word" Request Trigeer :
M CHOOL ™ g dese
S e T emnmmiation 150 et Trisaer
Bl M0 BOOL T g e
7 FiStatns Wond,
7| DEIDEW CHE s
| el Werd : : '
@ DBIDEW 0 THEX UWHBHON0IT W BH0003
11 L S PN, Y

D. Log in to the MGate 5102-PBM-PN web console. Click System Management
- Maintenance = PROFIBUS Control and the status for the operation
mode becomes Operate.
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5.2.2. Read Status Word Test

5.2.3.

After Test A (Write Control Word Test), set M 1.0 to true; then, click the
Active Modify Value icon. This sets Siemens PLC to send Acyclic Read
Command to MGate 5102-PBM-PN. The status value of DB2.DBW 0 should be
updated to W#16#0003.

ﬁlﬁble Edit [nsert PLC Wariable Wiew Options Window Help

| (@] & % [m(@]o]~| ¥| [z 2| 82| e v S[R] w

2 Adduess | Syrrbel | Dhsglay farrmt| Status value I-*.i.ﬁ(value
1 At "Control Word” Request Trigger l|
2 MO0  BOOL . false ,l trms
3 #Fead s Werd” Request Trizzer '
4 m BOOL
5 #Read "Commommication List” Request Trigeer
& M 20 - BOOL [ false ’
| e Wed y
B DEZDEW 0 HEX C WGk
T el W : : '
w| DBIDEW O HEX © O WHBH00T WA
T mmmmicaton | 15t : : '
Read Communication List Test

After Test B, set M 2.0 to true; then, click the Active Modify Value icon. This
sets Siemens PLC to send Acyclic Read Command to MGate 5102-PBM-PN. The
status value of DB2.DBB 2 should be updated to B#16#08 to indicate that
MGate 5102-PBM-PN is exchanging data (“Data_Exchange”) with PROFIBUS
Slave at address 3.

ﬁ Table Edit Insert PLC Variable Wiew Options Window Help

#| Dlla| 8| »[Bl@|o|| x| [Fx 2] x| e | i[] w

2 i |S:.rmh:\1 |Djsplayfmmat| Satsvalie  f bty value
1 MW ete "Contrel Word" Remquest Trigaer
2 M 0D BOOL . false I e
3| iead St Wond® Raqest Trgaer
o ST VIR BOOL g e
5 HRead "Commomnication List" Request Trizger

V20 | BOOL g false true

E

T it Word

5| DEIDEW O THEX WO

5[ ontel Wond

| DEIDEW 0 | HE uxlﬁ#ocoag W EROG3
| W ermmnmication 1 ist : '

2| DEIDEE 2 "DE Response Slaved00007 HEX B#16408

| DEIDEE 3 DB Respense" lavei0B0L HEX BHERD
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